EndNote & OSCOLA 4th Referencing Guide for Newcastle Law School

"Outstanding Library Team"
PART 1  (Pages 3-25)

Getting Started with EndNote and OSCOLA

Step-by-step instructions on how to use EndNote with the OSCOLA referencing style.

PART 2 (Pages 27-49)

EndNote Style Guide

A reference section listing a range of resource types and how these should be entered into EndNote.

This guide is available to download from the OSCOLA Referencing Style section of the Law Library Guide:
http://libguides.ncl.ac.uk/law

Icons by http://dryicons.com
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is EndNote, Accessing EndNote and Getting Help</td>
<td>4</td>
</tr>
<tr>
<td>Getting started with EndNote</td>
<td>5</td>
</tr>
<tr>
<td>Creating a new EndNote library</td>
<td>6</td>
</tr>
<tr>
<td>Getting to know your EndNote library</td>
<td>7</td>
</tr>
<tr>
<td>Copying and Backing-up your EndNote library</td>
<td>8</td>
</tr>
<tr>
<td>Adding References by hand</td>
<td>9</td>
</tr>
<tr>
<td>Adding different reference types</td>
<td>11</td>
</tr>
<tr>
<td>Importing books from the Library Catalogue</td>
<td>12</td>
</tr>
<tr>
<td>Importing from bibliographic databases</td>
<td>14</td>
</tr>
<tr>
<td>Removing duplicate references</td>
<td>17</td>
</tr>
<tr>
<td>Using groups to organise references</td>
<td>18</td>
</tr>
<tr>
<td>Using the OSCOLA referencing style</td>
<td>20</td>
</tr>
<tr>
<td>Working with EndNote and Word</td>
<td>21</td>
</tr>
<tr>
<td>Searching for citations to add within Word</td>
<td>23</td>
</tr>
<tr>
<td>Editing citations within Word</td>
<td>23</td>
</tr>
<tr>
<td>Editing the full reference in the bibliography</td>
<td>23</td>
</tr>
<tr>
<td>Adding subsequent citations to footnotes</td>
<td>24</td>
</tr>
<tr>
<td>How will my bibliography look?</td>
<td>25</td>
</tr>
</tbody>
</table>
WHAT IS ENDNOTE?

EndNote is a type of reference management software that can be used to:

- Organise your references and create your personal “library” of references
- Import references from some online resources including Library Search
- Add citations and footnotes to documents in Word
- Produce bibliographies

WHERE CAN I ACCESS ENDNOTE?

All the ISS PC clusters in the University - clusters will be running Office 2010 and have EndNote X6. It can be installed on any freestanding University PC.

X6 is available via the Remote Application Server (RAS)
http://ras.ncl.ac.uk/

You can buy a personal copy of the latest version of EndNote from the Adept Scientific Store http://edustore.adeptscience.co.uk/

GETTING HELP

Lots of FAQs and tips available on the EndNote Library Guide
http://libguides.ncl.ac.uk/endnote

Email helplines: lib-endnotehelp@ncl.ac.uk (HaSS and SAgE)
Liaison Librarians: helen.blanchett@ncl.ac.uk louise.gordon@ncl.ac.uk

EndNote Workshops: for a guided introduction to using EndNote. EndNote Surgeries: drop in with your queries for practical help.

See http://libguides.ncl.ac.uk/endnote for further details.
GETTING STARTED WITH ENDNOTE

You will now learn how to open EndNote and create your first EndNote library.

An EndNote library is where your references are stored. It is a single file which you save on your own file space – it has a .enl file extension (e.g. endnotelibrary.enl). You can use Groups to organise your references, for example by subject, module, chapter or assignment.

OPENING ENDNOTE FROM A CLUSTER PC

STEP 1  Click on Start > All Programs > Database Software > EndNote program

You may see a pop-up warning when running EndNote (depending on your web browser). It is a safe program authorised for use on campus, so allow it to run.

The first time you use EndNote you will see a screen similar to the one shown – this varies depending on the version.

Click Finish (do not select the checkbox).

EndNote Web is an online version of EndNote that can be accessed anywhere. It doesn't have as many features as desktop EndNote but can be a useful additional tool. See the EndNote Library Guide for further information on this product.
CREATING A NEW ENDNOTE LIBRARY

STEP 2

If this is the first time you have used EndNote, the Getting Started with EndNote window will appear - you will be asked to create a new Library or open an existing Library.

Click on Create a new library.

A new window will appear called New Reference Library.

Navigate to your own file space (your H:/ drive) and locate or create a suitable folder in which to save your library.

In the File name box call the new library: (Your Name)'s Library (default).

Ensure the Save as type box is displaying: EndNote library (*.enl)

Click on Save.

Your new EndNote library will then open – you currently have no references to display.
Note that your EndNote library has the following features:

**Groups pane** – you can create groups to organise your references or EndNote will sometimes create temporary ‘autogroups’ for example when importing references or working with a Word document.

**Reference list** – your references will be listed here and can be sorted using the headings at the top. These headings can be changed under Edit > Preferences > Display fields.

**Reference panel** – see and edit the details of a reference, view a preview in the selected style or see any attached PDFs.

**Display modes** – these allow you to switch between working with only your local EndNote library, with your library and online databases, or with databases alone.

**Layout** – alter the layout of the Groups panel and Reference panel.
When working with EndNote it is important to back-up your library.

_This information is for reference – if you are attending a workshop, please move on to the next task._

**Copying and moving your library**

Your EndNote library is made up of a set of files – a main .enl file and a supporting .DATA folder which contains associated files (PDFs, images etc). You can copy and move these files around like any other file – e.g. to a laptop or USB drive.

**Important!**

- When copying or moving a library, you need to move both the .enl file and the .DATA folder
- Do not put anything else into your .DATA folder
- The .DATA folder is created automatically and should not be deleted

**Making a compressed back-up copy of your library**

This technique will automatically save and compress your library and associated .DATA folder into a single file.

- Go to File > Compressed Library (.enlx)
- A new box will appear. Select Create, With File Attachments and All References in Library
- Click on _Next_
- Save the compressed library with a name you will recognise. Note the file extension changes to .enlx
ADDING REFERENCES BY HAND

In this task you will learn how to create an EndNote reference by hand. It is useful to know how to create references by hand to add those resources you may already have collected. However, the easiest way to create EndNote references is to import them from the library catalogue or a journal database.

OPENING A NEW REFERENCE TEMPLATE

STEP 4

From the menu across the top of your library, click on the New Reference icon. This will open a New Reference window.

Notice that Journal Article is chosen as the Reference Type by default.

You don't need to enter information into every field in the reference template, but you must fill in the first few fields which describe the key bibliographic information.

ENTERING BIBLIOGRAPHIC INFORMATION

STEP 5

Start by entering details of the article authors [you can use the examples below or use your own examples].

Note that each author's name must be added on a new line. Use the TAB key to move between fields. Add the following details:

- Type in the author: Watson, Irene
- Type in the year: 2002
- Type in the title: Buried Alive
- In the journal field type: Law and Critique
In the volume field type: **13**
In the pages field type: **253**

You reference will now look like this →

To save the reference, click on **File > Close Reference** – this will close the reference and it will be saved automatically. (You can also use the cross in the top-right to close the reference, but be careful to close only the reference and not EndNote!)

If you see a pop-up window at this stage, see the note below.

The first time you save a reference you may see a pop-up window asking if you want to save the changes.

Tick **Do not display the message** again and then click **Yes**. From now on, your changes will be saved automatically whenever you close a reference.
Click on **CTRL** and **N** (this is a shortcut) to bring up a blank *New Reference* window.

From the **Reference Type** menu, select **Web Page**.

Notice that the fields in the reference have changed – these are dependent on the type of reference you select.

Enter the following information:

- **Author:** The Law Society,
- **Year:** 2012
- **Title:** Your Guide to Probate
- **Publisher:** The Law Society
- **Access year:** 2012
- **Access date:** 25 October 2012

Note that if a web address does not begin with ‘www’ you would need to add ‘http://’ at the start of the address.

Close your reference and it will be saved.

Note that a corporate author requires a comma entering after the name (e.g. **Author:** The Law Society, ). Otherwise EndNote will try to format the name in a LastName/ initials format (e.g. **Society, TL**).

Use the **Research Notes** field to store personal reminders, such as the location of a quotation in a book or the quotation itself. **Keywords** can be used to assign relevant words which you can use for searching.
IMPORTING BOOKS FROM THE LIBRARY CATALOGUE

It is possible to search Newcastle University's Library catalogue from within EndNote and import references.

It is possible to export from Library Search but this cannot be done directly to EndNote at this time. You would need to export EndNote Web and synchronise with your main EndNote library. This is explained on the EndNote Library Guide at http://libguides.ncl.ac.uk/endnote

CONNECTING TO THE LIBRARY CATALOGUE

STEP 7

Open your EndNote Library.

Ensure the icon on the far left of the toolbar Integrated Library and Online Search Mode is selected.

Then click on the Tools menu and select Online Search.

Select Newcastle U and click Choose.

EndNote will then connect to the library catalogue.

Please note – this searches mainly book stock and does not search everything that Library Search can find e.g. journal articles.
Click on Show Search Panel and ensure Search Remote Library is selected.

From the first drop-down menu, select to search Title and then enter: legal skills. Click Search.

The Confirm Online Search box will appear, indicating the number of references you have found. If it is a large number, retrieving them from the catalogue may take a while, so choose to retrieve 1 through 10.

Click on OK to display the results.

The results display in EndNote – the references will automatically be added to your library, but note a new group has been created on the left called Newcastle U.

You can now sort through the references to decide which ones you want to keep or delete. Highlight a reference you want to delete then press the Delete key. Notice that the number under All References goes down.

To select more than one reference to delete, hold down the CTRL key while selecting the references.
IMPORTING FROM BIBLIOGRAPHIC DATABASES

You can search many online databases and import your search results into EndNote. This task takes you through two examples. You will also learn how to remove duplicate records.

Unfortunately it is not possible to import from the major legal databases into EndNote (LexisLibrary, Westlaw, Justis and HeinOnline). However, many of the general databases cover law so it is useful to know how to export from these databases.

IMPORTING FROM WEB OF KNOWLEDGE

STEP 9 ACCESSING WEB OF KNOWLEDGE

Go to the Law Library Guide http://libguide.ncl.ac.uk/law

Click on the General Databases tab and select Web of Knowledge.

SELECTING RECORDS

In the search box of Web of Knowledge type: "intellectual property law" (include the quotes). Leave the box set to search for Topic.

Click on search.

In your results list, mark some of the records by placing a tick in the box at the left of each record.
IMPORTING INTO ENDNOTE

Scroll to the bottom of the page to see steps 1-3:

Step 1: ensure Selected Records on page is selected
Step 2: ensure a tick is placed in the box next to 'plus Abstract'
Step 3: click on the EndNote icon (not EndNote Web) – this will begin the import.

If you are asked what you want to do with the file say ‘Open’. You may see pop-up blockers and warning windows when the references are imported – EndNote is approved software on campus, so it is ok to allow these. Alternatively, Web of Knowledge gives an option to force the export – click on the ‘Export’ icon if it does not happen automatically.

The references will automatically be added to your open library.

The My Library pane indicates how many records you have downloaded – these are listed under Imported References.

Select All References to see your whole library.
**IMPORTING FROM SCOPUS**

**SELECTING RECORDS**

- Go to the Law Library Guide [http://libguide.ncl.ac.uk/law](http://libguide.ncl.ac.uk/law)
- Click on the **General Databases** tab and select **Scopus**.
- In the Search Box type "*intellectual property law*" and click on **Search**.
- Mark some of the records by placing a tick in the box at the left of each record.

**IMPORTING INTO ENDNOTE**

From the top of the page click on the Export icon ![Export](export_icon.png)

You will then see the **Output page**:

- In section 1 select **Export**
- In section 2 use the drop down arrow next to **Export Format** to select **RIS format**

- Use the drop down arrow next to **Output** to select **Complete format**. Then click on the **Export** button.

- A **File Download** window will appear - click on **Open**
- Allow any pop up blockers. The references will be automatically added to your open Library
- The My Library pane shows how many references you have in total and how many references you have just imported. Click on **All References** to see your whole Library.
This information is for reference – if you try this now, you may find you don’t yet have any duplicates!

It is possible to search for duplicate records and remove duplicates:

- Make sure you are in ‘All references’ and from the **References** menu, select **Find Duplicates**
- The Find Duplicates window appears:
  
  ![Find Duplicates Window](image)

- Scroll down each record and compare the information – records imported from different databases may contain different amounts of information
- Use the **Keep This Record** button to decide which one to keep
- Continue this process for all the records (notice you can **Skip** if desired)
USING GROUPS TO ORGANISE REFERENCES

EndNote has a feature which enables you to organise sets of references in your EndNote Library into Groups. Default Groups are automatically displayed in the My Library pane on the left-hand side of your Library.

Groups are also created automatically when you import references from online databases and when you are working with Word and Endnote (using EndNote's Cite while you Write feature).

CREATING GROUPS

STEP 11 Go to Groups on the menu bar.

Note that you can Hide Groups if you do not want to use this feature and Show Groups to use it again – try this now.

Now click on Groups > Create Group.

A new group will appear on the left. Overtype the highlighted words New Group with Essay1

HINT

If you miss the opportunity to overtype New Group (e.g. by clicking somewhere else), simply go to the Groups menu and select Rename group – you will now be able to overtype the name again.
**ADDING REFERENCES TO A GROUP**

**STEP 12**

In the *My Library* pane on the left Click on *All References*.

Hold down the **CTRL** key and highlight 4 references.

Then click on Groups > Add references to > Essay 1.

(Note that you could also create a new group at this stage by selecting *Create Custom Group*.)

Group *Essay 1* now contains 4 references.

**SHORTCUT**

If you want to select a block of references to move - highlight the top reference, hold down the **Shift** key and highlight the bottom reference. You should find your whole block is highlighted ready to copy.

**ADDING REFERENCES TO GROUPS USING DRAG AND DROP**

**STEP 13**

You can add references to a group by highlighting and dragging them onto the Group:

- In the *My Library* pane on the left, click on *All references* to see all your Library
- In your reference list, highlight one or more references
- Left click and hold while you drag the cursor across to the *Essay 1* Group on the left
- Highlight and click on the *Essay 1* Group to check the reference has been added
THE OSCOLA REFERENCING STYLE

Styles dictate the layout of a reference in the bibliography, as well as the format of the in-text citation. EndNote provides over 5000 different styles, many relating to specific journals. Newcastle Law School uses OSCOLA 4\textsuperscript{th} Edition, which is a footnote style.

CHOOSING THE OSCOLA STYLE

STEP 14

Click on the \textbf{Output style} menu – this is where you can select your preferred style.

Click on \textbf{Select Another Style}.

The \textbf{Choose a style} window lists the 500 most commonly used styles.

Scroll through the list.

Highlight a style and click on the \textbf{Style Info/Preview} button to see how the style will appear in the bibliography.

Highlight OSCOLA 4\textsuperscript{th} and click on \textbf{Choose}.

It will be saved in your Favourites, which means it will show up in the \textit{Output style} menu next time.
WORKING WITH ENDNOTE AND WORD

EndNote and Word can be used together to create in-text citations and bibliographies in your documents. This uses EndNote’s Cite While You Write feature. This task will give you an introduction to this feature. You will need to open both Word and EndNote in order for them to work together.

This task is written for Word 2010.

OPENING WORD

STEP 15 Click on the Start menu and select All programs > Microsoft Office > Microsoft Word 2010.

Notice you have an EndNote tab in the ribbon at the top of the screen:

Ensure the OSCOLA 4th style is selected.

CREATING A DOCUMENT AND INSERTING CITATIONS

STEP 16 Type some text and then put your cursor in the document where you want your first citation to appear.

Click on References > Insert Footnote

A small number 1 will appear within your text but also in a footnote at the bottom of the page. Your cursor should have moved to the footnote – this is where your reference will be inserted.

From the EndNote ribbon click on EN Go to EndNote. This will take you to EndNote and create a working link between your Word and EndNote files.
Click on a reference in your EndNote Library to highlight it.

Check that the Style box is showing the **OSCOLA 4** style.

Then click on the curved red arrow **Insert Citation** icon in the toolbar.

The reference appears as a footnote at the bottom of the page:


It will also be inserted at the end of your document for your bibliography. The bibliography will be sorted by reference type so all books are listed together, all cases together etc.

Add some more text to your document and try adding some more citations to see how the reference list grows.

**NOTE** If you want footnotes for each page to start at number 1, change the Numbering from **Continuous** to **Restart each page** by clicking next to **Footnotes** and changing the numbering.

Notice that EndNote automatically creates a Group for your document as you write. This is a temporary group which disappears when you close Word.
SEARCHING FOR CITATIONS TO ADD

STEP 17 If your EndNote library is very large, an alternative way to add citations is to search for them each time you need to insert them.

- From your Word document, click on Insert Citation in the EndNote ribbon and then Find Citation.
- Type in the word buried and click on Find. Highlight the reference and click on Insert. Your in-text citation and reference will be inserted into your document.

EDITING CITATIONS

STEP 18 You can amend individual citations in your text, for example to add a page number to a direct quotation.

- Place the cursor in the text on the citation you wish to amend
- Click on Edit and Manage Citations in the Endnote ribbon in Word
- On the Edit Citation tab, in the Pages box type: 87 and click OK

EDITING THE FULL REFERENCE IN THE BIBLIOGRAPHY

STEP 19 If you need to amend a reference, for example if you have made a mistake when entering it into EndNote, it is possible to do this from within Word, so that your document will instantly reflect the changes.

- Put the cursor in the text on the citation for the reference you wish to amend. In the EndNote ribbon, click on Edit Library Reference
- In the EndNote Reference window make your amendments (e.g. change the date in the Year field). Close the reference to Save
- Go back to your Word document and note that the changes have been made. You may need to wait a moment – if it does not update click Update Citations and Bibliography
If you want to refer to the same source a second (or more) time, there is a way of briefly referring to the source rather than having to repeat a full reference again. This is done by providing a cross-citation in brackets to the footnote in which the full citation can be found. If the subsequent citation is in the footnote immediately following the full citation, you can generally use ‘Ibid’ instead.

This example shows a citation of a book which is first cited (in full) in footnote 1, cited again in footnote 26, with a cross-citation to footnote 1, and then cited again at footnote 27:


... 

26 Stevens (n 1) 110.

27 Ibid 271-278.

Please note:

- In the case of subsequent citations immediately following the full citation in footnotes, EndNote will automatically insert *Ibid*. Simply add the citation again as you would normally.

- If the page numbers are different you need to edit the citation (see earlier section **EDITING CITATIONS**) or type the page numbers by hand after *Ibid*.

- If the subsequent citation does not immediately follow in the footnotes, EndNote will insert a brief citation and you will need to edit the citation to add details such as original footnote number (n x) and page numbers, or type these details after the brief citation.

- Alternatively for subsequent citations you can insert a footnote and type in all the details by hand.
HOW WILL MY BIBLIOGRAPHY LOOK?

- References in your final bibliography will be arranged by reference type in alphabetical order and within each reference type by Author. All books will be listed together, then cases, then journal articles etc depending on which reference types you have chosen.

- When you come to printing your final bibliography you may want to add headings to make it clear which references are books, etc. Edited books will file separately from authored books, because they were created under the reference type Edited Book.

- You may want to change the order of items in your bibliography. To do this highlight the item, point your cursor to the new position in the bibliography and copy and paste the reference there.

- You can make alterations to your final bibliography without affecting the in-text citations by highlighting the relevant document and amending the text as necessary.

- If you want to print out your bibliography separately from your word document you can create and print a separate bibliography. To do this:
  - Open your EndNote library
  - Click on Edit > Select all
  - Select your required style from the current style menu in the top right-hand corner by clicking on the down arrow
  - Right-click on the highlighted references and click on copy formatted
  - Open a Word document and paste the references into it
ENDNOTE & OSCOLA STYLE GUIDE CONTENTS

About the OSCOLA 4th Edn EndNote Style Guide .......................................................... 29
How to use this guide ........................................................................................................... 29
Notes about this style .......................................................................................................... 29
Further references about OSCOLA .................................................................................... 30
Endnote reference types and OSCOLA heading numbers .............................................. 31
Cases .................................................................................................................................. 32
Legislation - use Statutes reference .................................................................................. 33
Books ................................................................................................................................. 34
Edited books, and translated books .................................................................................. 36
Contributions to edited books - use Book Section reference .......................................... 37
Encyclopaedias ................................................................................................................... 39
Hard copy Journal articles – use the Journals reference ................................................. 39
Electronic Journal articles & working papers – use Electronic Article reference ....... 41
Conference papers ............................................................................................................ 43
Theses ............................................................................................................................... 44
Websites and blogs – use Web page reference ................................................................. 45
Newspaper articles ............................................................................................................. 46
Personal communications ................................................................................................. 47
Generic reference type ....................................................................................................... 47
Making changes to the OSCOLA output style ................................................................. 48
OSCOLA bibliography templates ..................................................................................... 48
OSCOLA quick reference .................................................................................................. 50
### ABOUT THE OSCOLA 4TH EDN ENDNOTE STYLE & STYLE GUIDE

This style available at Newcastle University is the Basic/web/server style for OSCOLA (OSCOLA 4th edn, updated 25 April 2011). This is the most recent style. This style guide includes the minor updates contained within the 2012 OSCOLA update.

### HOW TO USE THIS GUIDE

- Follow the instructions for each reference type, using only the reference types listed, and only the fields indicated for each reference type.

- The formatting for each reference type is shown in a box, followed by examples of formatted *footnote* references and the data in the relevant fields in the reference.

- (Note that in bibliographies, the initials follow the surname – this is how the entry will appear in the Endnote Preview box.)

- Some Endnote reference types are suitable for more than one type of reference – see the ‘Endnote reference types and OSCOLA heading numbers’ table and ‘Also use for’ suggestions.

### NOTES ABOUT THIS STYLE

- Capitalise major words in titles (for cases, statutes, journal articles, books, reports etc; eg The History of Time).

- Only Reference Types that are formatted are described will show the reference appropriately. Text in Reference Types not included in the list below will appear in the Generic format.

- Text in fields not included in the formatting will not appear in the footnote or the bibliography, however it is not necessary to have text in all the formatted fields.

- The year is not included in several formats, however it may be useful to include it in the reference so that your library can be organized by date, or for when reformatting your references in other styles.
Use Edit Citation/Suffix or Edit Citation/Pages to add pinpoints/page numbers, section and subsections, notes, cross references etc, or simply add these details in the footnote outside the 'grey' Endnote field. Bear in mind that the Edit Citation/Pages function only allows insertion of spaces and numbers. When cross-referencing to an earlier footnote use Edit Citation/Suffix.

FURTHER REFERENCES ABOUT OSCOLA

More information about using OSCOLA style for referencing in EndNote, including examples, can be found in the next pages of this guide. The information is from OSCOLA 4th edn EndNote Style by Sandra Meredith, Faculty of Law, University of Oxford. It is included with the author’s permission.

This guide is also available from Oxford University’s OSCOLA webpages at

http://www.law.ox.ac.uk/publications/oscola_endnote.php

For more detailed information on OSCOLA see:-

http://www.law.ox.ac.uk/publications/oscola.php

For OSCOLA EndNote FAQs see:-

http://www.law.ox.ac.uk/publications/oscola_endnote_faqs.php

You might find Cardiff University’s online tutorial on citing references in OSCOLA style useful. See: - https://ilrb.cf.ac.uk/citingreferences/oscola/tutorial/index.html

To ensure you use the correct abbreviation for journal names, consult a reliable source such as the Cardiff Index to Legal Abbreviations:

http://www.legalabbrevs.cardiff.ac.uk/
<table>
<thead>
<tr>
<th>ENDNOTE REFERENCE TYPE</th>
<th>OSCOLA HEADING NUMBER</th>
<th>OSCOLA REFERENCE TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases (p.32)</td>
<td>2.1, 2.2, 2.3, 2.6.2, 2.6.3 2.7, 2.8</td>
<td>all cases</td>
</tr>
<tr>
<td>Statute (p. 33)</td>
<td>2.4, 2.5, 2.6.1, 3.2.5, 3.4.2, 3.4.5</td>
<td>primary and secondary legislation, Hansard, European Commission documents, books of authority and institutional works that have no author, and any sources without an author that should be presented entirely in roman font</td>
</tr>
<tr>
<td>Book (p. 34)</td>
<td>3.2.1, 3.2.2, 3.2.5, 3.4.3, 3.4.4</td>
<td>authored books, older works, books of authority and institutional works that have an author, Command Papers, Law Commission reports and any documents that require authors, titles in italics and bibliographic information in brackets</td>
</tr>
<tr>
<td>Edited book (p.36)</td>
<td>3.2.2</td>
<td>edited and translated books</td>
</tr>
<tr>
<td>Book section (p. 37)</td>
<td>3.2.3, 3.2.6</td>
<td>contributions to edited books, and encyclopaedias where the author of an entry should be included in the reference</td>
</tr>
<tr>
<td>Encyclopaedia (p. 39)</td>
<td>3.2.6</td>
<td>encyclopaedias such as <em>Halsbury’s Laws</em>, where the author is not included in the reference</td>
</tr>
<tr>
<td>Journal article (p. 39)</td>
<td>3.3.1, 3.3.2</td>
<td>all journal articles that are published in hard copy, even if sourced online, and case notes</td>
</tr>
<tr>
<td>Electronic article (p. 41)</td>
<td>3.3.4, 3.3.5</td>
<td>all journal articles that are only published online and working papers</td>
</tr>
<tr>
<td>Conference paper (p. 43)</td>
<td>3.4.5</td>
<td>conference papers</td>
</tr>
<tr>
<td>Theses (p. 44)</td>
<td>3.4.7</td>
<td>theses</td>
</tr>
<tr>
<td>Web page (p. 45)</td>
<td>3.4.8</td>
<td>websites and blogs</td>
</tr>
<tr>
<td>Newspaper article (p. 46)</td>
<td>3.4.9</td>
<td>newspaper articles, including online newspaper articles</td>
</tr>
<tr>
<td>Personal Communication (p. 47)</td>
<td>3.4.11 , 3.4.10</td>
<td>emails, letters, interviews and any source that requires a title with neither quote marks nor italics, and the date</td>
</tr>
<tr>
<td>Generic (p. 47)</td>
<td></td>
<td>any reference that requires an author, the title in italics, bibliographic information about the source (i.e., where it was published) and year of publication</td>
</tr>
</tbody>
</table>
CASES

1. **Case Name field**: put the party names in roman (ie not italic) font

2. **Reporter field**: put the full citation -- neutral citation if available, year of judgment, report abbreviation and first page – with punctuation. If the case is unreported, put the court and date in brackets in the Reporter field.

3. **Court field**: put the court abbreviation. This is only required if the case doesn’t have a neutral citation and is after 1865. Do not insert brackets.

4. **Call Number field** for ECJ Case Numbers.

5. For other cases, use any of the fields noted above. The information will appear as shown in the format box below.

6. You may wish to use the **Abbreviated Case Name field** for text for subsequent citations – generally this will be a short form of the party names.

**Cases format for footnotes**: Call Number Case Name Reporter (Court)

**Cases format for bibliography**: Case Name Call Number Reporter (Court)

<table>
<thead>
<tr>
<th>EXAMPLE - CASE WITH NEUTRAL CITATION</th>
<th>EXAMPLE – ECJ CASE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Case Name</strong> Malcolm v DPP</td>
<td><strong>Case Name</strong> Arne Mathisen AS v Council</td>
</tr>
<tr>
<td><strong>Call number</strong></td>
<td><strong>Call number</strong> Case T-344/99</td>
</tr>
</tbody>
</table>
### Example - Case with Report Only

<table>
<thead>
<tr>
<th>Case Name</th>
<th>Page v Smith [1966] AC 155 (HL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporter</td>
<td>[1966] AC 155</td>
</tr>
<tr>
<td>Court</td>
<td>HL</td>
</tr>
</tbody>
</table>

### Example - Unreported Case without Neutral Citation

<table>
<thead>
<tr>
<th>Case Name</th>
<th>Stubbs v Sayer (CA, 8 November 1990)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporter</td>
<td>Stubbs v Sayer</td>
</tr>
<tr>
<td></td>
<td>(CA, 8 November 1990)</td>
</tr>
</tbody>
</table>

### Legislation - Use the Statutes Reference

1. **Name of Act field**: put the full name (including the year and any identifying numbers) of the Bill, Act, SI, Treaty etc. If citing Council Directives, Regulations and Commission documents, include the citation.

2. **Short Title field**: insert suitable text for use in subsequent citations.

*Also use Statutes for: Hansard, parliamentary reports, European Commission documents and any sources without an author that should be in Roman font.*

### Statutes Format: Name of Act

<table>
<thead>
<tr>
<th>Example - UK Act</th>
<th>Example - EU Directive</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name of Act</strong></td>
<td><strong>Name of Act</strong></td>
</tr>
<tr>
<td><strong>Short Title</strong></td>
<td><strong>Short Title</strong></td>
</tr>
</tbody>
</table>
BOOKS

1. **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line. If the author is an organization, such as Law Commission, put a comma after the organization name.

2. **Year field**: put the year of publication of the version/edition you are citing (ie not year of first publication etc)

3. **Title field**: put the title with capital letters for the major words.

4. **Series Title field**: use this field for any additional information, such as editor(s), translator(s) or when the book was first published

   - **Publisher field**: put the publisher of the version/edition you are citing.
   - **Volume field**: enter the volume number in numerals here if the publication details of successive volumes vary (eg different year or publisher).

5. **Edition field**: put the edition of version/edition you are citing, using the form 2nd, 3rd, 4th etc, or rev for revised editions.

6. **Short Title field**: if required for subsequent citations of a book, enter a short title.

*Also use for*: the Books reference type can also be used for Reports, Command Papers, Law Commission reports, and any documents with authors, titles in italics and bibliographic information in brackets.

**Book format**: Author, *Title*, Volume (Series Title, Edition edn, Publisher Year)
<table>
<thead>
<tr>
<th>EXAMPLE</th>
<th>EXAMPLE – TRANSLATED BOOK</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
<td><strong>Author</strong></td>
</tr>
<tr>
<td>Gareth Jones</td>
<td>Zweigert, H</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td><strong>Year</strong></td>
</tr>
<tr>
<td>2009</td>
<td>Kots, H</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>Goff and Jones: The Law of Restitution</td>
<td>An Introduction to Comparative Law</td>
</tr>
<tr>
<td><strong>Series Title</strong></td>
<td><strong>Series Title</strong></td>
</tr>
<tr>
<td>1st sup</td>
<td>Tony Weir tr</td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
<td><strong>Publisher</strong></td>
</tr>
<tr>
<td>Sweet &amp; Maxwell</td>
<td>OUP</td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td><strong>Edition</strong></td>
</tr>
<tr>
<td>7th</td>
<td>3rd</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EXAMPLE – BOOK WITH VOLUMES</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
<td><strong>Author</strong></td>
</tr>
<tr>
<td>von Bar, Christian</td>
<td>Julian V Roberts</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td><strong>Year</strong></td>
</tr>
<tr>
<td>2000</td>
<td>Mike Hough</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>The Common Law of Torts</td>
<td>Public Opinion and the Jury: An International Literature Review</td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
<td><strong>Publisher</strong></td>
</tr>
<tr>
<td>CH Beck</td>
<td>Ministry of Justice Research Series</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td><strong>Volume</strong></td>
</tr>
<tr>
<td>2</td>
<td>1/09</td>
</tr>
</tbody>
</table>
1. **Editor field**: put the editor or translator’s name in the form Susan D Smith or Smith, Susan D. If there is more than one editor/translator, put each on a new line. If the editor is an organization, such as Law Commission, put a comma after the organization name.

2. **Year field**: put the year of publication

3. **Title field**: put the title with capital letters for the major words.

4. **Series Title field**: use this field for any additional information, such as editor(s), translator(s) or when the book was first published

5. **Publisher field**: put the publisher of the version/edition you are citing.

6. **Volume field**: enter the volume number in numerals here if the publication details of successive volumes vary (eg different year or publisher).

7. **Edition field**: put the edition of version/edition you are citing, using the form 2nd, 3rd, 4th etc, or rev for revised editions.

8. **Short Title field**: if required for subsequent citations of a book, enter a short title.

**Note**: For translations, such as *The Institutes of Justinian* example below right, de-link the document from Endnote when your work is complete, and replace (eds) with (trs), OR copy and paste the reference from the Preview window in Endnote and adjust it.

---

**Edited book format**: Editor (ed/eds), *Title*, Volume (Series Title, Edition edn, Publisher Year)
<table>
<thead>
<tr>
<th>EXAMPLE – EDITED BOOK</th>
<th>EXAMPLE – TRANSLATED BOOK</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Editor</strong></td>
<td><strong>Editor</strong></td>
</tr>
<tr>
<td>Jeremy Horder</td>
<td>Peter Birks</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td><strong>Year</strong></td>
</tr>
<tr>
<td>2000</td>
<td>1987</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>Oxford Essays in Jurisprudence: Fourth Series</td>
<td>The Institutes of Justinian</td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
<td><strong>Publisher</strong></td>
</tr>
<tr>
<td>OUP</td>
<td>Duckworth</td>
</tr>
</tbody>
</table>

**CONTRIBUTIONS TO EDITED BOOKS - USE THE BOOK SECTION REFERENCE**

1. **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.

2. **Year field**: put the year of publication

3. **Title field**: put the title with capital letters for the major words.

4. **Editor field**: put the editor’s name in the form Susan D Smith or Smith, Susan D. If there is more than one editor, put each author on a new line. If the editor is an organization, such as Law Commission, put a comma after the organization name.

5. **Book Title field**: put the book title in roman with capital letters for the major words

6. **Series Title field**: use this field for any additional information, such as editor(s), translator(s) or when the book was first published

7. **Publisher field**: put the publisher of the version/edition you are citing

8. **Volume field**: enter the volume number in numerals here if the publication details of successive volumes vary (eg different year or publisher).

9. **Edition field**: put the edition of version/edition you are citing, using the form 2nd, 3rd, 4th etc, or rev for revised editions.
10. **Short Title field**: if required for subsequent citations of a book, enter a short title.

**Also use for**: encyclopaedias when the author of an entry should be included in the reference.

**Contribution to edited book format**: Author, ‘Title’ in Editor (ed/eds), *Title*, Volume (Series Title, Edition edn, Publisher Year)

<table>
<thead>
<tr>
<th>EXAMPLE – BOOK CHAPTER</th>
<th>EXAMPLE – AUTHORED ENCYCLOPAEDIA ENTRY</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
<td>Author</td>
</tr>
<tr>
<td>John Cartwright</td>
<td>Friedrich, CJ</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td>Year</td>
</tr>
<tr>
<td>2009</td>
<td>1968</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>Title</td>
</tr>
<tr>
<td>The Fiction of the Reasonable Man</td>
<td>Constitutions and Constitutionalism</td>
</tr>
<tr>
<td><strong>Editor</strong></td>
<td><strong>Book Title</strong></td>
</tr>
<tr>
<td>AG Castermans</td>
<td>International Encyclopedia of the Social Sciences III</td>
</tr>
<tr>
<td>J Hijma</td>
<td></td>
</tr>
<tr>
<td>KJO Jansen</td>
<td></td>
</tr>
<tr>
<td>P Memelink</td>
<td></td>
</tr>
<tr>
<td>HJ Snijders</td>
<td></td>
</tr>
<tr>
<td>CJJM Stolker</td>
<td></td>
</tr>
<tr>
<td><strong>Book Title</strong></td>
<td></td>
</tr>
<tr>
<td><em>Ex Libris Hans Nieuwenhuis</em></td>
<td></td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
<td><strong>Publisher</strong></td>
</tr>
<tr>
<td>Kluwer</td>
<td>Kluwer</td>
</tr>
</tbody>
</table>
ENCYLOPEDIAS

1. **Year field**: put the year of publication of the volume.

2. **Title field**: put the title with capital letters for the major words.

3. **Edition field**: put the edition of version/editition you are citing, using the form 2nd, 3rd, 4th etc, or rev for revised editions.

*Also use for*: any source that requires a title in italics but no author or publisher.

**Encyclopedia format**: *Title* (Edition, Year)

<table>
<thead>
<tr>
<th>Example</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Halsbury’s Laws</em> (5th edn, 2010)</td>
<td><strong>Year</strong></td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td></td>
<td>2010</td>
<td><em>Halsbury’s Laws</em></td>
</tr>
<tr>
<td></td>
<td><strong>Edition</strong></td>
<td>5th</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

HARD COPY JOURNAL ARTICLES – USE THE JOURNALS REFERENCE

Use for all journals that are published in hard copy, even if you found the article online.

1. **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.

2. **Year field**: put the year of publication of the article.

3. **Title field**: put the title with capital letters for the major words.

4. **Journal field**: put the journal full name or a suitable abbreviation (see below for more information about journal abbreviations).

5. **Volume field**: put the volume number in numerals. If there is no volume number leave this field blank.

6. **Issue field**: include the issue number only if the page numbers begin again for each issue within a volume, in which case put the issue number in brackets immediately after the volume number.
7. **Pages field:** put the first page of the article here. It is also possible to enter the span of pages; only the first page will show in your references.

8. **Short Title field:** if required for subsequent citations, enter a short title. This is probably only useful if you are citing several articles by the same author.

**VERY IMPORTANT NOTE:**

All article citations will appear with round brackets for the year. Journals that have no volume numbers require square brackets around the year. To do this, at the end of your work, de-link the references from Endnote (using Convert to Plain Text or Remove Field Codes) and replace the round brackets with square brackets as necessary.

An alternative way to get the desired result for journals references would be to remove the Year field from the Bibliography and Footnotes templates, and to include the year in square or round brackets as appropriate in the volume field in your Endnote library.

**Journal article format:** Author, ‘Title’ (Year) Volume Journal Name/Abbreviation First page

<table>
<thead>
<tr>
<th>EXAMPLE – JOURNAL WITH VOL. NUMBER</th>
<th>EXAMPLE – JOURNAL WITH NO VOL. NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
<td>(in this example the round brackets have been changed ‘manually’ in Word to square brackets)</td>
</tr>
<tr>
<td><strong>J A G Griffith</strong></td>
<td><strong>Author</strong></td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td>Paul Craig</td>
</tr>
<tr>
<td>2001</td>
<td><strong>Year</strong></td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>2005</td>
</tr>
<tr>
<td>The Common Law and the Political Constitution</td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td><strong>Journal</strong></td>
<td>Theory, “Pure Theory” and Values in Public Law</td>
</tr>
<tr>
<td>Law Quarterly Review</td>
<td><strong>Journal</strong></td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>Public Law</td>
</tr>
<tr>
<td>117</td>
<td><strong>Pages</strong></td>
</tr>
<tr>
<td><strong>Pages</strong></td>
<td>440</td>
</tr>
<tr>
<td>42-67</td>
<td></td>
</tr>
</tbody>
</table>
JOURNAL ABBREVIATIONS

OSCOLA allows use of either the full journal name or the journal abbreviation. If you have been told to use the abbreviations, use the Cardiff Index preferred abbreviation (http://www.legalabbrevs.cardiff.ac.uk).

You could also use a Term List within EndNote to help you – a term list is a way of remembering standard formats for names so you enter information consistently. See the OSCOLA Referencing Style tab on the Law Library Guide for more detail http://libguides.ncl.ac.uk/law

ELECTRONIC JOURNAL ARTICLES AND WORKING PAPERS – USE THE ELECTRONIC ARTICLE REFERENCE

1. **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.

2. **Year field**: put the year of publication of the article (for your own reference only).

3. **Title field**: put the title with capital letters for the major words.

4. **Periodical Title field**: put the journal citation in full, including year of publication, volume or issue and journal name or abbreviation.

5. **Date Accessed field**: put the most recent date of access in the form: 1 January 2011.

6. **URL field**: put the web address of the paper, copied from the browser address bar.
   Look for the most succinct URL that will find the article, and avoid long URLs that include search terms. Check that the URL works in a different browser.

7. **Short Title field**: if required for subsequent citations, enter a short title.

If a pinpoint/page number is required in the footnote, use Cited Pages, which will insert the page number before the URL.

If the web address has a ‘www’ at the start there is no need to write http:// at the start of the web address.

Author
Graham GreenLeaf

Year
2010

Title
The Global Development of Free Access to Legal Information

Periodical Title
(2010) 1(1) EJLT

Date Accessed
27 July 2010

URL
http://ejlt.org/article/view/17


Author
John M Finnis

Year
2006

Title
On Public Reason

Periodical Title

Date Accessed
18 November 2009

URL
http://ssrn.com/abstract=955815
1. **Author field:** put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.

2. **Title field:** put the title with capital letters for the major words.

3. **Conference Name field:** put the title, location and date of the conference, with commas between each.

Also use for: any source that requires author, title in roman with quote marks, and information about the source in brackets.

**Conference paper format:** Author, ‘Title’ (Conference Name)

<table>
<thead>
<tr>
<th>EXAMPLE</th>
<th><strong>Author</strong></th>
<th><strong>Title</strong></th>
<th><strong>Conference Name</strong></th>
</tr>
</thead>
</table>
**THESES**

1. **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D.

2. **Year field**: year of submission.

3. **Title field**: put the title with capital letters for the major words.

4. **University field**: put the name of the university.

5. **Thesis type**: put the type of thesis followed by the word thesis.

Thesis format: Author, 'Title' (Thesis Type, University Year)

| Javan Herberg, 'Injunctive Relief for Wrongful Termination of Employment' (DPhil thesis, University of Oxford 1989) | **Author**  |  Javen Herberg |
|                                                                                                           | **Year**    |  1989         |
|                                                                                                           | **Title**   |  Injunctive Relief for Wrongful Termination of Employment |
|                                                                                                           | **University** | University of Oxford |
|                                                                                                           | **Thesis Type** | DPhil thesis |
WEBSITES AND BLOGS – USE THE WEB PAGE REFERENCE

1. **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.

2. **Year field**: put the date of publication of the webpage or blog.

3. **Title field**: put the title with capital letters for the major words.

4. **Publisher field**: put the website or blog name.

5. **Date Accessed field**: put the most recent date of access in the form 1 January 2011.

6. **URL field**: put the web address of the paper, copied from the browser address bar. Look for the most succinct URL that will find the article, and avoid long URLs that include search terms. Check that the URL works in a different browser.

If the web address has a ‘www’ at the start there is no need to write http:// at the start of the web address.

**Website/blog format**: Author, ‘Title’ (date of publication) Publisher/website/blog name <web address> date accessed

---

**EXAMPLE**

<table>
<thead>
<tr>
<th>Author</th>
<th>Year</th>
<th>Title</th>
<th>Publisher</th>
<th>Access Date</th>
<th>URL</th>
</tr>
</thead>
</table>

Sarah Cole, 'Virtual Friend Fires Employee' *(Naked Law, 1 May 2009)*

NEWSPAPER ARTICLES

1. **Reporter field:** put the author’s name in the form Susan D Smith or Smith, Susan D.

2. **Title field:** put the title with capital letters for the major words.

3. **Newspaper field:** put the name of the newspaper

4. **Pages field:** put the page of the article, preceded by the section of the newspaper if relevant.

5. **Issue date:** put the date of the newspaper in the form 1 January 2011.

**Newspaper article format:** Reporter, ‘Title’ *Newspaper* (Place published, date of issue) 
Section Page number <web address> date accessed

<table>
<thead>
<tr>
<th>EXAMPLE – PRINTED NEWSPAPER</th>
<th>EXAMPLE – ONLINE NEWSPAPER</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reporter</strong> Jane Croft</td>
<td><strong>Reporter</strong> Ian Loader</td>
</tr>
<tr>
<td><strong>Title</strong> Supreme Court Warns on Quality</td>
<td><strong>Title</strong> The Great Victim of this Get Tough Hyperactivity is Labour</td>
</tr>
<tr>
<td><strong>Newspaper</strong> Financial Times</td>
<td><strong>Newspaper</strong> The Guardian</td>
</tr>
<tr>
<td><strong>Place published</strong> London</td>
<td><strong>Place published</strong> London</td>
</tr>
<tr>
<td><strong>Pages</strong> 3</td>
<td><strong>Issue Date</strong> 19 June 2008</td>
</tr>
<tr>
<td><strong>Issue Date</strong> 1 July 2010</td>
<td><strong>Access Date</strong> 19 November 2009</td>
</tr>
<tr>
<td></td>
<td><strong>URL</strong> <a href="http://www.guardian.co.uk/commentisfree/2008/jun/19/justice.ukcrime">www.guardian.co.uk/commentisfree/2008/jun/19/justice.ukcrime</a></td>
</tr>
</tbody>
</table>
PERSONAL COMMUNICATIONS

Use for letters, emails, interviews etc.

1. **Title field**: put all relevant information and punctuation about the author (only required if someone else sent the letter or email or conducted the interview) and the description of the communication/interview itself.

2. **Date field**: in the form 1 January 2011. (For interviews, put place and date.)

**Personal communications format**: Title (Date)

---

GENERIC REFERENCE TYPE

Use for any reference that requires an author, the title in italics, bibliographic information about where the source (ie, where it was published) and the year of publication.

1. **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.

2. **Year field**: put the year of publication of the article (for your own reference only).

3. **Title field**: put the title with capital letters for the major words.

4. **Publisher field**: put relevant information about where the source was published.

**Generic format**: Author, Title (Publisher, Year)
MAKING CHANGES TO THE OSCOLA OUTPUT STYLE

In Endnote, go to Edit, then Edit Output Styles, and Edit OSCOLA 4th edn

To stop the bibliography building in your document as you write, go to Edit Output Styles and untick 'Include Citations in Bibliography' then Save this style. To produce a bibliography at the end of your work, tick 'Include Citations in Bibliography' and reformat/update your citations using the Endnote toolbar in Word.

To stop subsequent mentions of a citation in your footnotes from using the author only, Short Form of the citation, and/or ibid, make relevant changes in Edit Output Styles, Footnotes, Repeated Citations.

Use the Endnote Manual for information about downloading references, modifying templates and reference types, using groups and keywords and so on.

OSCOLA BIBLIOGRAPHY TEMPLATES

Follow the Endnote Help manual if altering the templates.

Footnote templates

The footnote templates are the same as the bibliography templates with the following exceptions:

- Author names are Firstname Lastname in the footnotes but Lastname, Initials in the bibliography
- The Cited pages field is added at the end of the footnote templates
- The Cases template has Call number (for ECJ case numbers) at the beginning: Call Number Case Name Reporter | (Court) | Cited Pages
OSCOLA QUICK REFERENCE GUIDE

PRIMARY SOURCES

Do not use full stops in abbreviations. Separate citations with a semi-colon.

CASES

Give the party names, followed by the neutral citation, followed by the Law Reports citation (eg AC, Ch, QB). If there is no neutral citation, give the Law Reports citation followed by the court in brackets. If the case is not reported in the Law Reports, cite the All ER or the WLR, or failing that a specialist report.

Page v Smith [1996] AC 155 (HL)

When pinpointing, give paragraph numbers in square brackets at the end of the citation. If the judgment has no paragraph numbers, provide the page number pinpoint after the court.

Bunt v Tilley [2006] EWHC 407 (QB), [2006] 3 All ER 336 [1]–[37]
R v Leeds County Court, ex p Morris [1990] QB 523 (QB) 530–31

If citing a particular judge:


STATUTES AND STATUTORY INSTRUMENTS

Act of Supremacy 1558
Human Rights Act 1998, s 15(1)(b)
Penalties for Disorderly Behaviour (Amendment of Minimum Age) Order 2004, SI 2004/3166

EU LEGISLATION AND CASES


EUROPEAN COURT OF HUMAN RIGHTS

Omojudi v UK (2009) 51 EHRR 10
Osman v UK ECHR 1998–VIII 3124
Balogh v Hungary App no 47940/99 (ECHR, 20 July 2004)
Simpson v UK (1989) 64 DR 188
### SECONDARY SOURCES

**BOOKS**

Give the author’s name in the same form as in the publication, except in bibliographies, where you should give only the surname followed by the initial(s). Give relevant information about editions, translators and so forth before the publisher, and give page numbers at the end of the citation, after the brackets.


**CONTRIBUTIONS TO EDITED BOOKS**


**ENCYCLOPEDIAS**


**JOURNAL ARTICLES**

- When pinpointing, put a comma between the first page of the article and the page pinpoint.

**ONLINE JOURNALS**


**COMMAND PAPERS AND LAW COMMISSION REPORTS**


**WEBSITES AND BLOGS**


**NEWSPAPER ARTICLES**

- Jane Croft, ‘Supreme Court Warns on Quality’ *Financial Times* (London, 1 July 2010)

---

This Quick Reference Guide is reproduced with permission.

Sandra Meredith Law Faculty University of Oxford [www.law.ox.ac.uk/oscola](http://www.law.ox.ac.uk/oscola)

---

51